
 

 





  Lumenera INFINITY CAPTURE 
Release 6.5.6  User’s Manual 

Copyright  2018  Page i 

Copyright Notice:  

Release 6.5.6 

Copyright © 2018 Lumenera Corporation.  All rights reserved. 

The contents of this document may not be copied nor duplicated in any form, in whole or in part, 
without prior written consent from Lumenera Corporation.  Lumenera makes no warranties as to 
the accuracy of the information contained in this document or its suitability for any purpose.  The 
information in this document is subject to change without notice. 

 

License Agreement (Software): 

This Agreement states the terms and conditions upon which Lumenera Corporation ("Lumenera") 
offers to license to you (the "Licensee") the software together with all related documentation and 
accompanying items including, but not limited to, the executable programs, drivers, libraries, and 
data files associated with such programs (collectively, the "Software"). 

The Software is licensed, not sold, to you for use only under the terms of this Agreement. 

Lumenera grants to you the right to use all or a portion of this Software provided that the Software 
is used only in conjunction with Lumenera's family of products.  

In using the Software you agree not to: 

a) Decompile, disassemble, reverse engineer, or otherwise attempt to derive the source code for 
any Product (except to the extent applicable laws specifically prohibit such restriction); 

b) Remove or obscure any trademark or copyright notices. 

 

Limited Warranty (Hardware and Software): 

ANY USE OF THE SOFTWARE OR HARDWARE IS AT YOUR OWN RISK. THE SOFTWARE IS 
PROVIDED FOR USE ONLY WITH LUMENERA'S HARDWARE AND OTHER RELATED 
SOFTWARE. THE SOFTWARE IS PROVIDED FOR USE "AS IS" WITHOUT WARRANTY OF 
ANY KIND. TO THE MAXIMUM EXTENT PERMITTED BY LAW, LUMENERA DISCLAIMS ALL 
WARRANTIES OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, WITHOUT 
LIMITATION, IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY, QUALITY 
AND FITNESS FOR A PARTICULAR PURPOSE. LUMENERA IS NOT OBLIGATED TO 
PROVIDE ANY UPDATES OR UPGRADES TO THE SOFTWARE OR ANY RELATED 
HARDWARE. 

 

Limited Liability (Hardware and Software): 

In no event shall Lumenera or its Licensor's be liable for any damages whatsoever (including, 
without limitation, incidental, direct, indirect, special or consequential damages, damages for loss 
of business profits, business interruption, loss of business information, or other pecuniary loss) 
arising out of the use or inability to use this Software or related Hardware, including, but not 
limited to, any of Lumenera's family of products. 

 

Product Warranty 

Lumenera Corporation warrants to the original purchaser that our cameras are guaranteed to be 
free from manufacturing defects for a period of four (4) years from the original date of purchase 
(after April 2015).  
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For complete product warranty details refer to the Lumenera web site. 

https://www.lumenera.com/support/warranty-information.htmlAny returning product, specifically 
those being returned under warranty, must follow the Returned Material Authorization (RMA) 
process. Any units being returned are to be properly packaged (in original packing – if possible). 
Lumenera will not cover damage sustained in shipping due to improper packing. 

For RMA instructions, please refer to the Lumenera website. 

https://www.lumenera.com/support/rma.html 

RoHS/WEEE Compliance Statement 

The Restriction of Hazardous Substances in Electrical and Electronic Equipment (RoHS) 
Directive was passed into law by the European Union (E.U.). It affects manufacturers, sellers, 
distributors and recyclers of electrical and electronic equipment containing lead, cadmium, 
mercury, hexavalent chrome, polybrominated biphenyl (PBB) and polybrominated diphenyl ether 
(PBDE). After July 1, 2006 the use of these materials will be banned in new products sold in 
Europe. The RoHS Directive complements the WEEE Directive. China is expected to adopt 
similar legislation within a similar timeline. 

The Waste Electrical and Electronic Equipment Directive (WEEE) aims to reduce the waste 
arising from electrical and electronic equipment and to improve the environmental performance of 
all those involved in the life cycle of these products. 

Lumenera is committed to protecting people and the environment and we are working on 
identifying any materials used in our processes that could pose a potential hazard to our 
employees, customers or the environment. 

For this reason we are committed to have all our products comply with the RoHS and WEEE 
directives. We are constantly improving our compliance with these directives. For more 
information on our compliance or to track our progress please refer to our website. 

 

Trademarks and Proprietary Names: 

Lumenera Scientific, INFINITY X, INFINITY 1, INFINITY 2, INFINITY 3, INFINITY 4, INFINITY 5, 
INFINITY1, INFINITY2, INFINITY3, INFINITY4, INFINITY5, INFINITYHD, INFINITYEP, and 
DeltaVU are trademarks of Lumenera Corporation.  This manual may refer to other product 
names, which may be trademarked by their respective companies, and are used herein for 
identification purposes only.  
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Federal Communications Commission (FCC) Statement 

This equipment has been tested and found to comply with the limits of a Class B or Class A 
digital device, pursuant to Part 15 of the FCC Rules.  These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
residential environment.  This equipment generates, uses, and radiates radio frequency energy, 
and if not installed and used in accordance with the instructions, may cause harmful interference.  
However, there is no guarantee that interference will not occur.  If this equipment does cause 
interference to radio or television reception, which can be determined by turning the equipment 
off and on, the user is encouraged to correct the interference by one of the following measures: 

 

 Reorient or relocate the receiving antenna.  

 Increase separation between the equipment and receiver.  

 Connect the equipment into an outlet on a circuit different from which the receiver is 
connected.  

 Consult the dealer or an experienced radio/TV technician. 
 

Any changes or modification to said product not expressly approved by Lumenera could void the 
user's authority to operate this device. 
 
Shielded and grounded cables and connectors must be used to meet FCC emission limits.  
Lumenera takes no responsibility for any radio or television interference caused by using cables 
or connectors other than those recommended. 
 
This device complies with part 15 of the FCC Rules.  Operation is subject to the following two 
conditions: (1) This device may not cause harmful interference, and (2) this device must accept 
any interference received, including interference that may cause undesired operation. 

 

European Community (CE) Statement 

Products: INFINITY 1, 2, 3, 4, 5, X, Lu1175, Lu1175X, Lu1205, Lu1135, Lu1165, Lw1235, 
Lu1275, Lu1335, Lu1375 and Lw1625 USB Scientific Cameras. 
 
Directives: 2001/59/EC (General Product Safety Directive) Self-declared 89/336/EEC (EMC 
Directive). 
 
Standards to which conformity is declared:   EN55024: 1998 

EN55022: 1998 (Class B) 
EN61000-3-2: 1995 
EN61000-3-3: 1995 

 
Manufacturer’s Name and Address:  Lumenera Corporation 

7 Capella Court 
Ottawa, ON 
K2E 8A7 
Canada 

 
Type of Equipment:  USB 2.0 or USB 3.0 Scientific Digital Camera 
 
First Year of CE Conformity: 2003 
 
This is to certify that the Lumenera USB 2.0 & USB 3.0 Scientific Cameras meet or exceed the 
standards for CE compliance per the Council Directives noted above.  All equipment is built at 
Lumenera Corporation, and pertinent testing documentation is available for verification. 
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1  

Introduction 

1.1 The Lumenera INFINITY Camera Family 

Lumenera INFINITY cameras are designed to be flexible microscopy imaging 
tools for Clinical, Research, Life Science, Materials Science and Educational 
Professionals.  INFINITY cameras are compatible with any USB 2.0 or USB 3.0 
equipped desktop, laptop or embedded computer running Microsoft, Windows 7, 
Windows 8.1 or Windows 10.  Both 32-bit and 64-bit platforms are supported. 

INFINITY cameras are designed with flexibility in mind.   Each camera model has 
its own distinct advantage over the others.  Whether your application demands 
speed, resolution or sensitivity, there is an affordable INFINITY camera to meet 
the requirements.  Because they are USB based, there is no need for a frame 
grabber.  Instead, most USB 2.0 camera models require only the single cable for 
both power, full command and control, and data transfer at speeds of up to 40 
MB/s resulting in real-time video preview.  Camera models designed to operate 
on a USB 3.0 interface typically require external power to reach maximum 
performance.  The power adapter is included with these camera models. 

All cameras have a provision to be externally powered for cases where the USB 
cable does not supply power (e.g. some USB cards on older laptop computers.) 
Contact your Lumenera dealer for optional power adapters. 

 

The INFINITYHD camera model is not supported by the INFINITY Capture 
application software, and is not discussed in this User Manual.  A separate 
package called INFINITYHD Capture is used to operate the INFINITYHD 
camera. 

 

MAC O/S - INFINITY camera models (with the exception of the INFINITY2-3 and 
the INFINITYX series, and the INFINITYHD) can be operated on a Mac 
computer.  The application software and supporting documentation is not 
included on CD, but must be downloaded from the Lumenera Support page of 
the web site – www.lumenera.com 

http://www.lumenera.com/
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2  

Getting Started 

2.1 Software Installation 

The INFINITY camera you have just purchased is designed to operate out of the 
box with minimal set-up.   

Note: Prior to plugging the camera into the computer, you must first install the 
software. 

The software can be found on the CD-ROM that shipped with your product.  New 
releases and updates to the INFINITY software are available for download from 
the Lumenera web site. 

2.1.1 Minimum System Requirements 

 Windows 10, 32 or 64-bit 

 Windows 8.1, 32 or 64-bit  

 Windows 7, 32 or 64-bit (Service Pack 1) or 

 Windows VISTA, 32 or 64-bit (Service Pack 1), or 

 Windows XP, 32 or 64-bit (Service Pack 3)  

 1.3 GHz Pentium IV or higher (compatible) 

 2 GB or more above the memory consumed by the operating system, 
is recommended 

 USB 2.0 port (a USB 3.0 Port is recommended for the INFINITY3 and 
INFINITY5 series cameras that use a USB3.0 connection).  

Note: At minimum, a USB 2.0 Port is required.  The camera will not 
work on a standard USB 1.1 port. 

2.1.2 Camera Power Requirements 

Most of the INFINITY USB 2.0 camera models typically run off of the USB 
interface. In certain cases or specifically with USB 3.0 camera models, there is a 
need to externally power the camera. Please refer to Section 2.4 for more 
information on selecting the appropriate power supply for your camera. If an 
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incorrect external power supply is used, it could damage the camera and void 
your warranty. 

2.1.3 Installation Procedure 

The INFINITY camera you have just purchased is designed to operate following 
a simple setup procedure.  Prior to plugging the camera into the computer it 
is necessary to first install the software, which is included on the CD-ROM 
that shipped with your product. The INFINITY software can also be downloaded 
from the Support -> Microscopy _> Drivers & Downloads sections of the 
Lumenera web site. Follow the steps below for simple installation: 

 

Installation Steps: 

1. If you are using a 3rd party USB 2.0 PCI add-in card, please ensure 
the add-in card is properly installed on your computer before 
proceeding.  

2. You must ensure you are logged into the computer with Administrator 
privileges prior to continuing the installation. 

3. Close all application software that is running and then insert the INFINITY 
Installer CD into your CD-ROM drive. 

4. Double-click on “setup.exe”, or wait a few moments for the auto-play 
function to load the setup program automatically. 

5. Follow the onscreen prompts to install the software drivers and user 
application.  

6. After the software has been installed, plug the INFINITY camera into a 
free USB port. If your camera came with a power supply, connect it to the 
camera at this time. 

7. Run the INFINITY CAPTURE application software from your Start menu to 
control the camera.  

2.1.4 Software Upgrade Procedure 

The Software Upgrade procedure is similar to the original software installation. If 
you have installed a previous version of the software the installation procedure 
will detect the previous software version and indicate that an upgrade will be 
performed.  

2.2 Technical Assistance 

If you need assistance with the installation or use of the software, or, if you need 
help with general camera operation, please contact your retailer or dealer first. If 
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you still need assistance you can contact the Technical Assistance Centre (TAC) 
via email at: 

    support@lumenera.com 

 or by phone at +1-613-736-4077 (press 2 from the auto attendant) 

 

To obtain the latest software release and other technical information you may 
visit our technical support website at: 

https://www.lumenera.com/support/microscopy/drivers-downloads.html 

Our support website contains technical information available to the general public 
such as Frequently Asked Questions (FAQ’s).  For our Lumenera customers we 
provide a Knowledge Base with more product specific solutions and a Download 
Centre for customers to obtain the most recent software releases. 

As a customer, you will need to provide the TAC with some basic information to 
gain access to the customer Knowledge Base and the Download Centre.  Please 
provide the following details via email to support@lumenera.com to obtain a user 
name and password: 

 Your name, Company Name, address and telephone number 

 Your camera model and serial number 

 Your purchase information (e.g. did you purchase from an OEM or 
distributor?) 

Upon providing the above information, you will receive your access information 
via email from a TAC representative. 

2.3 Installed Software 

All of the necessary software and device drivers are contained in an installation 
program on the CD-ROM that comes with the camera.   

The following files are installed when you run the installation program: 

INFINITY CAPTURE Application:  Lumenera provides a free, easy to use 
capture application with all of the features required for basic camera functionality 
and image capture. 

INFINITY ANALYZE Application: Included on some CDs is Lumenera’s 
INFINITY ANALYZE software. This software provides advanced camera control, 
measurement functions and image enhancement options including stitching, 
annotation and archiving. The application has extensive context sensitive help for 
all its features.  Older models of INFINITY cameras may require a license 
upgrade to operate this package.  Refer to the INFINITY ANALYZE User Manual 
for additional details. 

https://www.lumenera.com/support/microscopy/drivers-downloads.html
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INFINITY TWAIN Interface: A plug-in driver will be installed by the installation 
program that will allow all INFINITY cameras to be used with any 3rd party 
software application that supports a TWAIN device.  

2.4 The INFINITY Camera 

All INFINITY cameras have a high-speed USB port found on the back of the 
camera.  Once the INFINITY camera software has been installed on your 
computer, simply plug the camera into a USB compatible port.  An LED light 
between the power jack and USB port will illuminate once the camera device 
drivers have been loaded and the camera is ready to use.  

Many INFINITY camera models will operate from USB power alone.  A DC power 
port is located on the rear of all INFINITY USB camera models allowing for the 
camera to receive power where either an older laptop or desktop PC is unable to 
deliver sufficient current or where multiple INFINITY cameras are being operated 
simultaneously on the same computer, or where a USB 3.0 compatible camera is 
being connected.   

For the INFINITY3-1 (cooled), INFINITY3-3, INFINITY3-6, INFINITY3S-1, and 
the INFINITY5 camera models, the supplied power adapter should be used to 
power the camera, as the power supplied by the USB interface is not sufficient 
for optimum performance.  In all cases, verify the input power requirement on the 
label of the camera and verify that it matches the adapter. 



Lumenera INFINITY CAPTURE   
User’s Manual  Release 6.5.6 

Page 6  Copyright  2018 

The power adapter supplied has the following specifications: 

1. 5 Volts DC Regulated  

2. 500-3000 mA Minimum Current Rating (Depending on Model) 

3. 2.1 mm tip, Center positive (+) 

 

Power adapter requirements and part numbers for ordering can be found on the 
Lumenera web site at this URL… 

 

https://www.lumenera.com/support/microscopy/installation-power-guides.html 

 

The camera is equipped with an industry standard C-Mount lens mount, which is 
compatible with standard C-Mount lenses or microscope mounts.   

The INFINITYX-32 camera is unique in that it utilizes DeltaVU™ a patent-
pending technology that increases the resolution of captured images to as much 
as 32 megapixels (6464 x 4864) with true non-interpolated color at each pixel 
location. 

The INFINITY5 series cameras can stream live video over HDMI directly to a 
monitor or projector, without needing to be connected to a PC.  These cameras 
include buttons on the camera case to power on the camera and perform a white 
balance operation.  When used with only the HDMI cable, the camera uses a 
continuous auto exposure/auto gain function to respond to changing light levels.  
When the camera is connected to the computer via a USB3.0 cable, the 
INFINITY CAPTURE application provides access to a variety of camera controls 
and settings, and allows for image capture or the recording of short video clips. 

https://www.lumenera.com/support/microscopy/installation-power-guides.html
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3  

Using the Camera 

3.1 INFINITY CAPTURE 

INFINITY CAPTURE is a powerful and flexible yet simple software application for 
the Live Preview, Optimization and Capture of digital images from any of the 
INFINITY cameras.   

It is supported by Windows and has a graphical user interface with standard pull 
down menus, an icon based toolbar and keyboard commands, which make it 
very simple to control the camera and take images.   

The following sections describe the usage of the software and explain the various 
camera settings and how they relate to the changes viewed in the live and 
captured images.  

3.2 Launching the Application 

To launch INFINITY CAPTURE from your Windows Start menu: 

      or  or  

Select:    [All] Programs > Lumenera > INFINITY > INFINITY CAPTURE 

(If you elected to install the software in a different location, the software will 
launch from the folder you specified) 

Only one camera may be controlled by each instance of INFINITY CAPTURE, 
but several instances of the application may be run simultaneously.  If more than 
one camera is detected by the application, a list of cameras and their 
corresponding serial numbers is displayed allowing you to select the camera you 
wish to control.  

3.2.1 Main Window 

The main window can be seen in Figure 1.  When INFINITY CAPTURE starts up, 
the program’s live preview window also starts.  The main window has the toolbar 
with the most common program actions available for quick access. 
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Figure 1 - INFINITY Camera Main Window 

3.3 Selecting Image Size 

3.3.1 Image Preview Size 

When the INFINITY CAPTURE application is launched a live preview window is 
automatically displayed, in addition to the application control dialog (Figure 1). 
The live preview window shows the camera output, enabling the sample to be 
framed and focused on the microscope, and allowing the result of any settings 
adjustments to be seen in real time.  The camera model is identified in the Image 
Preview window title, along with the output frame rate (when this feature is 
enabled from the Options menu) for the current Region of Interest (ROI) size and 
exposure time (Figure 2). 

 

 

 

 

 

Figure 2 - INFINITY Camera Live Preview Window 
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You may choose any one of the available resolution settings from the drop down 
list on the main window for video preview as depicted in Figure 3.  Depending on 
the camera model, the available selections will be different.  The output frame 
rate on your computer will vary depending on the choice of preview resolution.  
With each step down in resolution, you will utilize a smaller area of the camera’s 
sensor (smaller field of view) resulting in less video data and increased frame 
rates.  The exception to this is the sub-sampled mode, which utilizes the entire 
area of the sensor (full field of view) but skips rows and columns of pixels to 
reduce the amount of image data.  In some cameras, a binned mode is available 
which works in a similar way to the sub-sampled mode except the pixels are 
summed together to produce a brighter, more sensitive image. Selecting this 
mode results in a higher frame rate but with less detail.  Note: some camera 
models only provide a monochrome output when operating in a binning mode. 

 

 

Figure 3 - Image Preview Size 

 
INFINITY5 NOTE:  The INFINITY5 series cameras include a specific Preview 
Resolution in the dropdown menu that enables the simultaneous HDMI output 
(1920x1080) from the camera when both the USB3.0 and the HDMI cables are 
connected.  While any preview resolution from the dropdown list can be selected 
to control the camera output to the PC over the USB 3.0 interface – the HDMI 
output will only be enabled.  Certain constraints apply when the camera is 
operating in HDMI output mode.  For example, the frame rate must be fixed at 
60fps, and thus the maximum exposure time is limited to 16.66ms, and the 
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continuous auto exposure/gain function is enabled to control the scene 
brightness.   

3.3.2 Capture Resolution 

Image capture resolution is selected through the drop down list in the main 
window similarly to the Image Preview Size.  Capture resolution is independent 
of preview resolution.  This represents the resolution of the image that is 
captured.  

INFINITY5 NOTE:  The INFINITY5 series cameras also support using either the 
same or different resolutions for live preview and image capture.  If the live 
preview is set to the HDMI stream output size, but the capture image resolution is 
set to a different format – the HDMI output will be temporarily suspended when 
an image is being captured.  The live preview on the PC, and the HDMI live 
stream will automatically resume a few seconds after the image capture occurs. 

 

The INFINITY X camera has 4 different DeltaVU™ resolutions available for each 
preview resolution (in addition to the standard “Demosaic” method used by all 
other cameras.)  This patent pending technology allows for much higher 
resolution captures by performing sub-pixel shifting of the imager.  

The preview and capture resolutions can be locked so that they both change 
when changing either one. 

    

Figure 4 - Resolution lock 

3.4 Image Optimization 

3.4.1 Exposure 

Optimizing the exposure of your INFINITY camera is achieved through moving 
the exposure slider, Figure 6.  Based on the camera model, you have different 
exposure ranges available.  Fine exposure slider adjustments can be made using 
the left and right arrow keys on your keyboard when the exposure slider is 
selected.   As exposure is adjusted, the frame rate is kept at the maximum 
possible. 

Image brightness can also be managed using the Automatic Exposure Control 
(AEC).  Selecting this option will change the exposure time slider to a range that 
represents the average image intensity value over a range of 0 to 255.  Select 
the value for the desired average pixel intensity and the camera will automatically 
adjust the exposure time to achieve that target. This option is useful in an 
environment where the optical magnification is frequently being adjusted.  
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INFINITY5 NOTE:  The INFINITY5 camera models retain an auto-exposure 
target value that is persistent even during power down.  Use the AEC target 
brightness adjustment with the INFINITY5 camera connected via USB3.0 to the 
computer, and this setting will be retained and used the next time the camera is 
connected via HDMI only, as the target brightness value that the continuous auto 
exposure will use as reference 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: The INFINITY3S-1UR & INFINITY1-2CB camera 
models are designed to display a default live video 
preview using a frame rate that is slightly reduced from 
the maximum.  This is to ensure optimal image quality.  
The fastest frame rate output can be achieved by 
selecting the Ext FR checkbox to the left of the exposure 
slider – when either of these two camera models is 
connected. 
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Figure 5 - INFINITY CAPTURE with AEC turned on 

Some cameras have an extended exposure range, indicated by an Extended 
Range check box just above the exposure slider.  When not in extended 
exposure mode, the exposure is limited but has high granularity so that very 
precise exposure settings can be made.  When the option is selected, the 
exposure can be increased to the maximum allowed by the camera, but with 
fewer increments available.   

Note: If you have image averaging turned on and are using 
long exposures, you may have to wait a long time to capture 
an image. Also, when using very long exposures (several 
seconds) especially with high gain, noise may be present in 
the image in the form of random hot pixels and vertical bars. 
These can be minimized by using the flat field correction 
function of the application. 

The INFINITY CAPTURE application provides a pair of exposure sliders to 
control the camera.  The upper control defines the exposure time used for the 
live video preview.  The lower control specifies the exposure time to be used for 
captured images. Typically, these two sliders respond in tandem as the capture 
and preview exposures should be the same.  Under certain circumstances, such 
as fluorescent microscopy, it is desirable to specify a much longer exposure time 
for captured images, where the sample, illumination source, filters dictate a much 
longer exposure.  In these cases, check the Alt. Exp setting to the left of the 
lower exposure control.  This allows the camera to use an Alternate Exposure 
setting for all captured images.  
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3.4.2 Gain 

Adjusting the global electronic gain of your INFINITY camera increases the 
sensitivity without increasing the exposure.  The slider is under the exposure 
slider on the main window as depicted in Figure 6.  The global gain of each 
INFINITY camera model is optimized on start up.  General image quality may 
decrease as the gain is adjusted upward because the noise in the image is also 
amplified along with the image signal.  

 

 

Figure 6 - Exposure and Gain Control 

Note: When using very long exposures (several seconds) 
especially with high gain, noise may be present in the image 
in the form of random hot pixels and vertical bars. These can 
be minimized by using the flat field correction function of the 
application. 

 

INFINITY5 NOTE:  When the HDMI output mode is specified for the 
preview resolution, the camera gain slider is disabled. The camera 
controls both the exposure and gain settings to produce the desired 
scene brightness while constrained to deliver the 60  

3.4.3 Selecting the Light Source 

Each light source emits light at a specific frequency resulting in a specific color 
temperature.  Color temperature measurement is typically referred to in degrees 
Kelvin (K).  Warmer Halogen light sources have temperature in the 3000 K 
range.  Fluorescent light sources have a temperature in the 4000 K range and 
daylight conditions have cooler color temperatures in the 5500 K range.  
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Figure 7 - Selecting the Light Source 

Your INFINITY camera is set to Halogen as a default. Selecting the light source 
that best suits your working environment will help in optimizing your images.    

From the Options menu, you can select the light source as depicted in Figure 7, 
based on the lamp being used for your microscopy applications.  If you are using 
filters on the light source, you should choose the light source that best matches 
the filter.  For example, on a microscope with Halogen lighting, if you use the 
standard daylight filter, you should select Daylight as the light source.  Try each 
of the Light source settings to determine the one that produces the most accurate 
color representations in the displayed image. 

3.4.4 White Balance Target 

Your INFINITY color camera has the ability to adjust the colors in your image 
based on the current lighting conditions.  In order to adjust and accurately 
represent the colors within your image, you must first perform a white balance.   

As a first step, select a light source that accurately represents your working 
conditions, described above.  Next, select a target color that most accurately 
represents the current working conditions.  For a microscopy application this will 
be the background color when viewing a sample through the eyepieces.  

The default target color on start-up is white and in most cases this is the desired 
choice.  However, when viewing an image with the microscope eyepiece, 
especially when color filters are being used, the background color is sometimes 
non-white.  If you want the colors captured by the camera to be as close as 
possible to the colors you see down the eyepiece you should select a color target 
from the Available White Balance Target Colors that closely matches the 
background color.  The target color dialog can be accessed by selecting the 
“bull’s eye” icon from the toolbar or from the dropdown menu as depicted in 
Figure 88.  
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Figure 8 - White Balance Target Dialog Access 

 

 

You can select a target color, simply by clicking or dragging the mouse pointer in the top 
window of the dialog depicted in Figure 9.  The selected color appears in the bottom 
window.  Alternatively, you can select the Red, Green and Blue values of the color.  

 
 
 
 
 

 

 

Figure 9 - White Balance Target Dialog 
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3.4.5 White Balance 

There are three methods available to adjust the white balance: 

1. One Shot Global 

This method balances the colors over the entire field of view.  For best 
results, move your sample out of the field of view.  If you are using a 
transmitted light microscope, move to a clear area of the slide.  If operating a 
stereomicroscope, use the white base or a white piece of paper to represent 
the background.  Perform the One Shot Global White Balance (WB) function 
by selecting the Globe icon from the toolbar, or by selecting One Shot Global 
from the Camera > White Balance drop down menu as depicted in Figure 10.  

INFINITY5 NOTE:  The INFINITY5 camera model includes a button on the 
top of the camera case to initiate a white balance adjustment to the current 
lighting conditions.  It presumes that the field of view does not contain any 
color target, and performs a global white balance.  The button is intended for 
use when the camera is operating without a USB3.0 connection to a 
computer, however it will perform the same operation as using the One Shot 
Global white balance within the INFINITY CAPTURE application.  If the White 
Balance operation is initiated from the application software the updated 
settings will be retained on the camera, and will be used the next time the 
camera is operated while disconnected from the PC, until a subsequent WB 
operation is performed. 

 

 

 

 

Figure 10 - White Balance / One Shot Global 

 
2. One Shot Spot 

Under certain circumstances, users may wish to adjust white balance based 
on a small area within the sample area.  In these cases, One Shot Selection 
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is the method of choice.  To access the One Shot White Balance, select the 
crosshair icon from the toolbar, or select One Shot Spot from the camera drop 
down menu as depicted in Figure 111. 

Once selected, move the cursor to the area of your image that you want to 
white balance (the mouse pointer changes to a cross hair when the mouse is 
in the image preview window) and select it.  The size of the spot on the image 
used for the white balance is 32 x 32 pixels.  You can cancel the operation 
prior to clicking on the image display by reselecting the icon or menu item. 

 

 

 

 

Figure 11 - White Balance / One Shot Spot 

 
3. Adjust Manually 

It is possible to manually adjust the color balance by changing the individual 
color gains.  This is helpful where slight adjustments to the white balance are 
required or when the One Shot methods are unable to achieve a good 
balance.  The sliders that control the red, green and blue gains can be 
accessed via the tricolour icon on the toolbar or by selecting Adjust Manually 
from the Camera > White Balance drop down menu as depicted in Figure 12. 
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Figure 12 - White Balance / Adjust Manually 

Not all cameras have a green gain adjustment.  In those cases, simply adjust the 
Red and Blue gains together, higher to remove green and lower to add green.  
The gain values represent multiplicative factors.  The Initialize button will set all 
gains to one and the Reset button will reset the gains to the values they had 
when the dialog was popped up. 

 

 

Figure 13 - Manual Gain Adjustment Dialog 

 

Note:  If you use an extreme white balance target color, a 
proper white balance may not be achievable using the one 
shot or manual methods.  Likewise, under extreme lighting 
conditions (very warm or very cool) proper white balance 
may be difficult to achieve.  In the latter case, try using a 
color filter to bring the light temperature closer to the daylight 
standard of 5500K.   
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3.4.6 Hue and Saturation 

Hue is a term typically used to describe the tone in your image.  Adjusting the 
hue changes the appearance of the image by shifting the color spectrum 
incrementally.  It’s not a substitute for white balance but can be used to give 
images a warmer or cooler tone.  

Saturation typically refers to the dominance of color intensity within your image.  
A low saturation image looks dull and adding saturation can make the colors 
more vibrant. 

The dialog for Hue/Saturation adjustment can be accessed via the rainbow icon 
on the toolbar or by selecting Hue/Saturation from the Camera drop down menu. 

 

 
 

 

Figure 14 - Hue / Saturation Dialog 

 

The sliders are used to adjust the hue and saturation, increasing when moved to 
the right and decreasing when moved to the left.  By moving the saturation slider 
all the way to the left, all color is removed from the image making it appear 
monochrome or grayscale.  The Initialize button will set the Hue & Saturation to 
zero and the Reset button will reset the Hue & Saturation to the values they had 
when the dialog was popped up.      

3.4.7  Contrast / Brightness / Gamma 

The dialog for Contrast/Brightness/Gamma adjustment can be accessed via the 
light bulb icon on the toolbar or by selecting Contrast/Brightness/Gamma from 
the Camera drop down menu. 
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Figure 15 - Contrast / Brightness / Gamma Dialog 

Adjusting the contrast affects the brightness relationship between the dark and 
light areas in your image.  Adjusting the slider to the right increases contrast, 
making dark areas darker, bright areas brighter and eliminating brightness levels 
in between.  Moving the slider to the left decreases contrast causing the 
brightness of the image to become more uniform and flat. 

Adjusting the brightness affects the overall image intensity. Moving the slider to 
the right and left makes the image brighter and darker respectively.  

Gamma adjustment affects the bright, dark and between areas of your image in a 
non-linear fashion.  The purpose of gamma is to correct the non-linearity in most 
display devices.  Gamma values greater than 1.0, will brighten the darker areas 
of an image without over brightening the bright areas.   For most monitors, a 
good gamma value will lie in the range 1.3 to 2.0. 

The Initialize button will set the Contrast and Brightness to zero and the Gamma 
to one.  The Reset button will reset the Contrast, Brightness and Gamma to the 
values they had when the dialog was popped up. 

3.5 Capturing an Image 

3.5.1  Capture Image 

There are two steps to capture and save an image.  

 First, select if you want to set the camera into 16 bit mode by selecting this 
option from the Options menu 

 Next, select the Capture Image Icon (or use <Ctrl> G) to capture the 
image and display it on screen. 

 Finally, select the Save Captured Image Icon to save it to disk.  
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These commands are also available from the drop down menu. 

 

INFINITY5 NOTE:  The INFINITY5 cameras include a button on the case that 
initiates an image capture.  The large center button is designed for easy 
access.  When the camera is connected to via USB3.0 to the computer AND 
the INFINITY CAPTURE application is running, pressing the button on the 
camera will result in an image being captured.  If auto-saving has been 
configured in the application, images will be saved as specified.  Otherwise, 
the captured image appears in a separate window on the computer, and the 
operator can decide whether to save it permanently to storage media using 
the File menu in the image title bar. 

 

 

Figure 16 - Capture and Save Image 

 You have a choice of four file types to select from when saving 8 bit 
images and two file types for 16 bit images.  JPEG and Bitmap file types 
do not support 16 bit image saves.  Note that JPEG images are 
compressed and there will be some loss of image detail with that format.  
All other formats are uncompressed with no loss of image detail. This 
application uses the default JPEG compression ratio provided by your 
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Windows operating system. This application does not allow you to change 
this compression ratio. 

 

 

Figure 17 - Image Saving File Formats 

3.5.2  Settings files 

Use the options to save settings to store the current camera settings to disk.  The 
load settings option will restore the camera settings from a previously saved 
settings file.  You can also export the current camera settings into a presets file 
that can be accessed within INFINITY ANALYZE.  This option will enable the 
same camera configuration parameters to be quickly assigned to the camera in 
both Capture and ANALYZE. 

3.6 Other Options 

3.6.1 Light Source Frequency 

The light source frequency settings simply limit the available exposure times that 
can be used in order to avoid the flickering or banding caused by lights operating 
on AC power sources.  When using DC powered lights, as most microscopes 
have, the DC setting may be selected and there will be no restriction on the 
allowable exposures.  When an AC power source is used for the illumination, the 
appropriate frequency should be selected from the choices 60 Hz or 50Hz.  

Note: This option is disabled when AEC is turned on. 

3.6.2 Preview Quality 

The video displayed in the preview window can be set to either: “Optimize for 
Speed” or “Optimize for Quality”.  The default setting is to use the maximum 
frame rate which reduces the CPU usage but the live preview image quality is 
reduced. This setting does not affect how images are captured.  Captured 
images always use the highest quality algorithms to process the raw data from 
the camera into full color images When the “Optimized for Quality” option is 
selected, a higher percentage of the CPU is used when previewing and may 
result in a slightly slower video rate on some slower computers.  

NOTE: This menu function has a specific behaviour that 
applies to the INFINITY3S-1UR, INFINITY3-3UR & 
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INFINIITY3-6UR camera models only.  Selecting Optimize 
for Speed will enable the camera sensor to operate in its 
fastest output (quad-tap) mode.  Selecting Optimize for 
Quality limits the camera sensor output to a slower frame 
rate by employing single-tap mode.  For exposure times 
above 66ms, selecting Optimize for Speed will have no 
impact on frame rate. 

3.6.3 Capture Quality 

INFINITY USB 3.0 camera models operate at very fast frame rates.  Live preview 
images are acquired from these cameras while the CCD sensor is operating in a 
multi-tap mode.  To minimize the level of electronic artefacts that may appear in 
a captured image as a result of multi-tap mode, a setting is provided to disable 
the multi-tap mode under the Options -> Capture Quality menu, by selecting 
Optimized for Quality. 

3.6.4 Preview Zoom Level 

The preview window can be set to “Actual Size (100%)”, which will display the full 
field of view at its actual size.  Selecting “Half Size (50%)” will shrink the display 
50% in each direction while maintaining the full field of view.  This option is useful 
when previewing large resolutions that are larger than the monitor’s display size.  
A digital zoom is applied to the camera output when zoom factors larger than 
100% are selected.  Whenever the preview image cannot fit on the computer 
monitor, the application adds scroll bars to the side and bottom of the window, for 
navigation.  The available zoom factors are: 25, 50, 100, 200, 400, and 800%.  

3.6.5 Flat Field Correction 

3.6.5.1 Generate Image  

Flat Field Correction is used to correct for uneven lighting and other fixed 
pattern non-uniformity in the image. This action is used to generate the 
correction to be applied to the image.  Before selecting it, you should make all 
your imaging adjustments (exposure, gain, etc.) and then remove any sample 
from the field of view so that you only have an empty “background” image.  
Once the correction is generated, it can be applied using the “Enable 
Correction” option.  

3.6.5.2 Load Image 

Calibration images that have been previously collected can be restored using 
this function.  Only calibration files that are known to be appropriate for the 
existing lens and illumination conditions should be loaded.  If there have been 
any alterations to the optics or the lighting, a new flat field calibration should be 
performed. 
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3.6.5.3 Save Image 

Use this function to save a flat field calibration image to disk, to be restored for 
use during another session, or after the lens and lighting conditions have been 
returned to the state when the calibration was performed 

3.6.5.4 Enable Correction 

This action applies the flat field correction that was generated in the previous 
action.  When enabled, the correction will be automatically applied to both the 
live preview and the captured image.  If you change the resolution of the 
preview, the correction will be reset and disabled.  If you change the field of 
view, by selecting a different objective lens, for example, you should regenerate 
the correction for the new field of view.  

3.6.6 Image Flipping 

 

 
 

Image flipping (vertical) and mirroring (horizontal) are available from the Options 
drop down menu or the left-right, up-down arrow icons on the toolbar.  Selecting 
these options will flip the preview image 180° either vertically or horizontally.  
This option also affects the captured image. 

 

INFINITY5 NOTE:  Use the Image flip / mirror operations when an INFINITY 5 
series camera is connected via USB3.0 cable to a computer, to set the correct 
orientation for the camera image.  The camera retains the image orientation 
settings, making the choice persistent, even when the cables are disconnected 
and the camera is powered down.  The next time the camera is connected to an 
HDMI monitor, the image orientation will remain as it was last configured. 

3.6.7 Multiple Image Averaging 

This feature is accessed through the Options drop down menu.  Image averaging 
is an effective tool to reduce random noise in your images.  To enable this 
feature, you select the Multiple Image Averaging option from the Options Menu.   

3.6.8 Multiple Image Settings 

You can change the number of images that are averaged together using the 
Multiple Image Settings Dialog, which is accessed by selecting the Multiple 
Image Settings option in the Options menu.   

When enabled, every time you capture an image the number of images you 
selected will automatically be collected and averaged together. 
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This feature is not supported by the INFINITY X when capturing high-resolution 
(DeltaVU™) images. 

3.6.9 Preview Histogram 

 

 
 

A real-time intensity histogram can be overlaid on the preview window.  This 
histogram can be used as a guide to setting the image properties such that the 
full dynamic range of the image sensor is being utilized.  To display the preview 
histogram, select Preview Histogram from the drop down Options Menu or select 
the histogram icon from the toolbar. 

3.6.10 Highlight Saturated Pixels 

This option allows you to highlight the pixels in the image that are at or near 
saturation.  Saturation in this case refers to the brightness of the pixel.  The 
upper 5% of pixel values will be changed to the selected color and as they get 
closer to their saturated value and will get progressively darker as they reach 
their saturation level.   

 

Figure 18 - Saturation Overlay Dialog 

There are four highlight color options available for color cameras: black, red, 
green and blue, as shown in Figure 18. Only black highlights are available for 
monochrome cameras. A count of saturated pixels can also be presented in the 
video preview window by selecting the Display pixel count option.  

To highlight saturated pixels and/or count them, you need to select the Highlight 
Saturated Pixel option on this dialog. 
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3.6.11 Bitmap Overlay 

Any arbitrary bitmap can be overlaid on the live preview display or captured 
image.  A set of digital reticles is included with the application that can be used 
for measurements or to aid object indexing and alignment. Figure 19 shows the 
Bitmap Overlay Control dialog box. 

Once the bitmap is loaded, you select from the Options Menu to overlay on the 
preview image and/or the captured image. 

You can also create your own bitmaps to overlay, using any paint program.   The 
bitmap must have a width that is evenly divisible by four and must be in RGB24 
format, but other than that, there are no restrictions.  Any part of the bitmap that 
is pure white (RGB = 255, 255, 255) will be transparent with any other color 
overlaying and replacing the image data. 

If the overlay is smaller than the preview or captured image, the overlay can be 
placed in nine specific locations using the Position radio buttons.  

The overlay can be selected to appear on either the live preview or on the 
captured images, or both.  The Options menu lists both of these options, and 
they are also available on the Overlay dialog. 

The overlay can also take advantage of Alpha channel blending. The Alpha 
blending dictates how much of the image is seen through the overlay. You can 
make the overlay transparent, opaque or anywhere in between globally or use an 
Alpha blending bitmap file to use different blending values across the images.  

 

Figure 19 - Bitmap Overlay Control Dialog 
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An alpha blending bitmap can be used whenever an overlay bitmap is being 
used.  This bitmap affects the way the overlay bitmap is actually overlaid.  It is 
often undesirable to have the bitmap completely obscure the image data.  The 
alpha blending bitmap will cause the overlay to blend with the image data making 
it less obtrusive.  It can also be used to make a solid bitmap, like a logo for 
example, into a watermark that can be used to tag images without hiding the 
image underneath it. 

The alpha bitmap has the same restrictions as the overlay bitmap, and must be 
the same size as the overlay bitmap.  The way it works is as follows:  The value 
of each pixel in the alpha bitmap indicates the level of transparency of the pixel at 
the same location in the overlay bitmap.  Pixels that have a value of 255 are 
treated as completely transparent so that only the pixel from the original image is 
used.  Pixels that have a value of zero are treated as completely opaque so that 
only the pixel from the overlay bitmap is used.  The transparencies of the pixels 
in-between vary linearly with their value.  The blending is done independently for 
each of the three color-channels (R, G & B), which allows for some interesting 
effects, such as changing the color of the overlay, not just blending it with the 
image. 

The reticles bitmaps included with the application can be used as their own alpha 
blending bitmaps.  If you use any one of the gray reticles, they will simply blend 
the coloured reticles into the image to varying degrees.  The dark gray will blend 
a little bit, the gray will blend half and half and the light gray will blend a lot.  For 
interesting effects, try experimenting with using the color reticles as alpha 
bitmaps. 

3.6.12 Keep Main Window On Top 

This option forces the main application window to remain in front of all other 
windows on the desktop. 

3.6.13 Load Camera Settings / Save Settings / Save Settings As 

 

 
 

At any time, you can save the current settings of the camera and application to a 
file for later retrieval and use.  When the application exits, it saves the current 
settings to a file that is automatically loaded the next time it is run.  With your own 
settings files, you can quickly jump between different resolutions, exposures etc. 

Save Settings, will save the settings to the currently loaded file (if it exists).  Save 
Settings As, allows you to use a different file. 
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3.6.14 Restoring the Main Dialog Position 

At any time, you can restore the location of the INFINITY CAPTURE main dialog 
on your desktop by selecting the Restore Main Dialog Position option of the 
Window menu, as shown in Figure 20. This option will move the dialog box back 
to the center of your desktop. 

 

 

Figure 20 - Restore Main Dialog Position Option  

3.6.15 Restoring the Live Preview Dialog Position 

There may be times when you need to move the live preview window around on 
your desktop. You can restore its position by selecting the Restore Live Preview 
Position option from the Window menu.  This option will move the live preview 
window to the upper left position of your desktop. 

 

 

Figure 21 - Restore Live Preview Position Option 

3.6.16 Restoring the Image Preview Dialog Position 

There may be times when you need to move the image preview window around 
on your desktop. You can restore its position by selecting the Restore Image 
Preview Position option from the Window menu.  This option will move the image 
preview window to the upper left position of your desktop. 

 

 

Figure 22 - Restore Image Preview Position Option 
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3.6.17 Auto-Saving Captured Images 

The auto-saving feature of the INFINITY CAPTURE application saves every 
captured image into a specified directory of your choice using a common file 
name. Each image file is numbered and can start at any number and have a 
specified number of digits.  

 

 

Figure 23 - Auto-Saving Option 

The auto-saving dialog provides some options to how the files are saved. The 
save directory, filenames and file types can be selected. You can chose to 
overwrite any existing file or continue from an existing set of captured images.  

Each saved image will have the same filename with an appended number. This 
number can start anywhere and can have any number of digits. The only 
restriction is that the final filename (filename, digits and extension) must not 
exceed your operating system’s filename size limit (typically 256 characters).  



Lumenera INFINITY CAPTURE   
User’s Manual  Release 6.5.6 

Page 30  Copyright  2018 

 

Figure 24 - Auto-Saving Dialog 

3.6.18 Focus Meter 

The focus meter dialog provides a means of determining the proper focal position 
of either the microscope or a camera lens to ensure properly focused images 
from the camera. It provides an indicator that represents the level of sharpness in 
the image. As the focus is adjusted, the sharpness in the image increases and, 
as a result, the focus gauge value increases. Proper focus is achieved when the 
focus meter gauge bar reaches its highest value. The maximum value used for 
the focal range can be modified to improve the accuracy of the focal 
measurements. If, during a focus calibration, the focus meter gauge bar graph 
reaches the right-side of the scale before achieving proper focus, increasing the 
Maximum Scale value changes the scale of the bar graph allowing for more 
precise focal adjustments. The Maximum Scale value has a range from 1-4095. 

 

Figure 25 - Focus Meter Dialog 

3.6.19 INFINITY3-1 Camera Cooler Control 

The INFINITY3-1 camera includes a cooling device that can reduce the 
temperature of the sensor to improve its noise response with longer exposures.  
The INFINITY3-1U model is not equipped with the capability to provide sensor 
cooling.  INFINITY Capture provides a feature that activates the cooling unit on 
demand.  Select the Cooler On option of the Camera menu. The blue light on the 
front of these cameras indicates when the camera coolers are on and running. 
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Figure 26 - INFINITY3 Camera Cooler Option 

These cameras can also report their current sensor temperature. The Cooler 
Settings… option provides the current sensor temperature of the camera. These 
cameras are able to cool the sensor by about 30°C.  For the cooling unit to 
operate, an external 5V power supply must be connected to the camera. 

 

 
 

 

Figure 27 - Cooling Settings Option and Dialog 

3.6.20 AVI Capture Settings 

Not only can you capture individual images but you can capture a video clip from 
the camera and save it to an AVI file.      

To begin capturing video clips, first configure the AVI capture settings. Hitting the 
API Capture Settings button brings up the dialog shown in Figure 288.  
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Figure 28 - AVI Capture Settings Dialog 

Select a filename and location for the AVI video clip. Next select the video file 
type for the AVI file. Note there are three types available as shown in Figure 299.  

 

 

Figure 29 - AVI Video File Types 

Select the duration of the video clip you wish to capture. You have the option of 
having the video preview to the screen while capturing the video clip. Note that 
having this option selected may slow down the camera frame rate and result in 
lower frame rates in the captured video clip. 
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Note: Setting the duration to large values can create extremely large files, 
depending on the camera resolution and frame rate. To minimize this, you may 
want to reduce the preview window size when capturing video clips.  

3.6.21 Capturing AVI files 

 

 
 

Once you have setup the AVI capture settings, you can begin to record your 
video clips. The video will be saved to a temporary file containing the raw video 
images captured from the camera. This temporary file can be viewed directly by 
the INFINITY CAPTURE’s AVI File Playback.  

Note: To view this file with other AVI playback applications, you will need to 
convert this file to a standard AVI file or compress it with the XviD filer (see 
section 3.6.20 for more information on this AVI compression filter). 

3.6.22 AVI File Playback 

 
 

You can playback any type of .avi file with the INFINITY CAPTURE’s AVI 
playback feature. This feature can playback raw files that were captured from 
your INFINITY camera that have not been converted to a standard AVI file. 
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Figure 30 - AVI Playback Dialog 

The INFINITY CAPTURE AVI playback dialog allows you to play, pause, stop 
and scan to any location in the AVI file. You can rewind and fast-forward through 
the AVI playback through the slider control provided. 

3.6.23 Converting AVI files 

The INFINITY CAPTURE can capture, convert and save .avi files in one step. 
You can also capture only the raw data from the camera and convert it at a later 
date. To do this, select the Convert AVI File… from the options menu. 

 

Figure 31 - AVI Convert Dialog 

In the Input File Name, select the RAW AVI file that was captured previously, as 
shown in Figure 31. In the Output File Name, select or provide a destination AVI 
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file name. Finally, select the video file type you want the output file to be and hit 
the Convert AVI button.  

3.7 Using INFINITY Cameras with TWAIN 

Many programs support camera control and image capture directly using the 
standard TWAIN protocol.  Paint programs, Microsoft Office applications as well 
as a wide variety of scientific software applications identify and run the INFINITY 
cameras through the supplied TWAIN interface. 

The operation of the TWAIN interface is virtually identical to the INFINITY 
CAPTURE application.  The only difference is that when you capture an image, 
instead of displaying in on screen, it passes it to the underlying TWAIN enabled 
application.  There is no facility to save images directly to a file using the TWAIN 
interface. 


